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[dot]BlendMagz didedikasikan untuk para Blender Army di Indonesia.Sebagai bentuk support terhadap FORUM

Blender Indonesia dan perkembangan Blender di dunia. Magz ini mengupas perkembangan Animasi Blender dan

Project OpenSource sekal igus mendukung Digital Artist & Studio Berbasis Open Source. What Next? Tentu saja sebuah

project besar yang bernama Open Movie Hingga project-project inovative local artist yang diharapkan

GO International .

HELLO!Blender Army











Blender Indonesia

berkesemptan mengisi

talkshow dalam rangkan

1001 Inspiration Design

Festival Minggu 28 Februari

2010. Acara ini bertempat di

atrium Central Park Jakarta

dan diwaki l i oleh Hiza dan

Udey sebagai narasumber.

Secara global acara

berlangsung meriah,

inspiratif, dan lancar.

” Mascot Competition – Mascot For central

park: Challenge Your Imagination”

Sebagai kompleks properti baru yang meghias

wajah Jakarta dengan pendekatan yang inovatif,

Central Park bekerja sama dengan Majalah Desain

Grafis Concept dan International Design School

mengundang semua insan kreatif yang berj iwa

muda dan trendy untuk turut meramaikan ajang

1001 Inspiration Design Festival Central Park

Masc ot Competition 2009.

Kal i ini , kompetisi melombakan desain maskot

yang dapat mewaki l i spirit Central Park sebagai

destinasi hiburan, belanja, bisnis dan hunian

eksklusif dengan konsep green design.

.workshop

.about





Sudah jam satu kurang seperapat. . . saya pikir

gak pada dateng. akhirnya makan aja dulu lah

berhubung perut dah kerubukan.

Hehehe. . . tiba2 ada yg nongol dua orang dari

CCA (Cimahi Creative Association) mas Tino dan

mas Aldi gak nyangka juga karena mereka

kebingungan cari2 saya dan gak sengaja l iat

saya lagi buka page blenderindonesia.org :p

kebetulan yg menyenangkan. . .

Di tengah2 obrolan kami, muncul dua orang lagi

dari Pongo Studio. mereka adalah mas Berto

dan mas Antony. Sungguh menggembirakan

mereka bisa hadir, karena Pongo adalah studio

pionir yg ful l menggunakan blender dan

software open source untuk karya2 mereka.

Dari situ, saya langsung merasa dikel i l ingi oleh

orang2 hebat karena dari obrolan2 tersebut

kel iatan bgt mereka punya visi dan ideal isme

yg patut saya kagumi.

CCA (Cimahi Creative Association) punya hajatan besar sekitar Juni nanti yaitu peresmian gedung Baros yg disupport langsung oleh

pemkot CImahi untuk digunakan bagi kepentingan perkembangan industri kreatif di CImahi . Mas Aldi yang menjabat sebagai ketua

bidang animasi di CCA punya rencana besar untuk menggiatkan industri kreatif di CImahi , tidak hanya di animasi , tapi di l ini kreatif

la in yg lebih luas. Bahkan rencana untuk membuat one stop community service juga akan dirintis di gedung Baros tersebut,

diantaranya untuk membuat cafe KASKUS, studio animasi , studio game juga sekolah animasi . that's cool ! ! ^_^ [JO]
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Hel lo Army! Pelatihan Animasi Blender di Surabaya

yang diadakan oleh B.A.R.S. (Blender Army Regional

Surabaya) berjalan sukses. Pelatihan yang bersifat free

ini di serbu puluhan pendaftar. Alhasi l pelatihan yang

hanya mampu untuk menampung 24 peserta ini

terpaksa membagi peserta menjadi 2 gelombang.

Untuk gelombang 2 rencananya akan diadakan pada

tanggal 8 Mei 2010. Karena jatah untuk 2 gelombang

telah penuh maka pendaftaran peserta ditutup.

Pelatihan Animasi Blender gelombang pertama ini

sukses. Peserta yang hadir ada 20 peserta. Yang pal ing

mengejutkan ada seorang peserta yang masih duduk

di bangku Sekolah Dasar. Pelatihan yang dimulai pada

jam 11.30 ini mencakup materi introduction, model l ing

dan texturing. Tutor dari materi ini adalah mas

Adhicipta R. Wirawan. Untuk pertemuan lanjutan dari

Gelombang 1 akan membahas Rigging, Animasi dan

Editing Video.

Bagi yang ingin mendownload materi pelatihan

tersebut si lakan download pada l ink di bawah ini .

http://www.mediafire.com/?jnzotjzxqjz

Si lakan download dan bagikan secara gratis.

Kami juga tidak akan menolak j ika anda berminat

untuk memberikan donasi .
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3D Challenge HOBBY

JOGING buatan Wisnu

Sekty ini berhasi l

menyisihkan beberapa

saingan. Rapih,

komplek, dan bercerita.

Tanpa narasi pun pasti

sudah banyak yang bisa

menebak gambar

apakah ini . Selamat!



.modelling
Rencananya membikin moster

yang sudah dimulai tempo hari .

Model ing di Blender 2.49

(karena masih ketergantungan

mouse gesture saat model ing)

dan proses selanjutnya menggunakan

versi 2 .5 alpha 2 (sekal ian latihan

engan antarmuka yang baru),

bagian kaki dan ekor belum sempurna

.sculpting
Kaki dan ekor sudah beres,

ditambah hasi l sculpting.

Untuk berikutnya untuk kul it yang masih "mulus" akan

diberi tekstur "cloud" dengan normal mapping, agar

muncul tekstur kasarnya, ditambah lagi model ing alas

untuk si figure.

3D Challenge HOBBY

silver figure monster

.VOIDARK

02

VOIDARK

Teknik sculpting menawan dari voidark. Penguasaan material dan

kerapian model menjadikan action figure ini berhak menjadi pi l ihan juri

sebagai pemenang kedua.



.update
Ceritanya bahannya itu

terbuat dari plastik. Di

sekitar l ingkar cangkir mug

dipermanis dengan hiasan

pita, cute sekal i .

Tidak ada hiasan lain selain

pita. Namun warna yang

feminim menjadikan bentuk

mungi l cangkir terl ihat manis.

.modelling
Mo nyoba bikin mug. . .skal i2

mau bikin something yang

girly. . .haha.

Minnie Mug. Model ing

dimulai dengan bentuk

global obyek mug dengan

poly seefektif mungkin.

m
in

i
m

u
g

CHRISVI
.sculpting
Update: hari ini hari

scultping si Mug,

rencananya texturenya

mau langsung di blender

aja. . .dan ada tambahan

model logo Blendernya.

Semoga selesai tepat

waktu,semangat buat

yang lain : )

. logo

GAMBAR REFERENSI

3D Challenge HOBBY

.CHRISVI

03

Mug ini adalah pemenang kedua 3d

chal lenge #1 Blender Indonesia. Tema

utama hobby direspon Chris dengan sangat

hari-hati . Mungkin ada alasan khusus

kenapa ia memil ih obyek mug. Hmmm.. .

Render hasi l akhir sangat menawan dengan

internal render. Beberapa sisi mug sedikit di

pahat beserta logo blender yang berkesan

empuk. Walau sederhana namun kesan

bahan terl ihat sempurna.

Logo Blender tidak dibuat

seperti biasa.

Pada gambar nampak

sekal i logo dibuat bergaya

sesuai dengan bentuk

dasar mug yang bulat.



.MECHANIMATION
04

3D Challenge HOBBY



.WCTERBANG
05

3D Challenge HOBBY



.GUNKZMILE
06

3D Challenge HOBBY



.FAJAR
07

3D Challenge HOBBY



.ADHI & MAXRIOT
08
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.deskripsi
In i bukan video animasi 3D tetapi lebih kearah

visual efek dan cuma 3 detik.

Video ini dibuat dari tutoria l After Effect, cuma mau

nge-bukti in kalau blender jg bisa digunain kyak AE, hanya butuh kerja

keras.

Efek ini namanya submerge jd kamera masuk ke dalam tanah trus

nyambing ke ruang yang laen. Memakai modifier uv projection untku

membentuk ruangan. Sedang bagian lapisan tanah memainkan uv saja.

YOUTUBE http: //www.youtube.com/watch?v=Q8dPZ7hbOo0

[wc terbang]
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Visual Efek: Dibawah Monas



.deskrisi
Animasi ini buat ikutan Nu Green Tea Video Contest.

Blender 4.9b, tim produksi ada 4 orang.

Durasi: 50 detik

Wisnu Sekty (GoodBoy): Ide Cerita, Sutradara, Model ing,

Texturing, Lighting dan Render

Wahyu Septian (HYU): Rig Face and kontroler, compositing,

sound dan editing

Kurniawan A (KUGAN): Rig Basic, kontroler dan animasi

Sukmo Hadi P (Sukhoi): Animasi

Waktu produksi: 1 minggu

http://www.nahninu.com/Videos/Video-Contest/798/Cerita-Nunu-Bersama-Nu-Green-Tea.html

.Cerita
Sebagai seorang pelajar, belajar adalah salah satu kebutuhan bagi Nunu. Dia suka

belajar dimanapun dan kapanpun. Tapi belajar itu kadang juga membosankan dan

bikin bete, Nunu punya cara sendiri biar tetap semangat. Dia selalu minum Nu

Green tea yang membuat semangatnya bal ik lagi . So, bersihkan diri dan temukan

semangatmu untuk jalani hari .

Cerita Nunu Bersama Nu Green Tea
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tutorialkalengjoget
Materi Pelatihan Animasi menggunakan Blender

H i-TECH Mall Surabaya 1 0 Apri l 201 0
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http: //www. youtube. com/watch?v=1 rSf0r4lupkyoutube!
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http: //www.youtube.com/user/ndundupan#p/a/u/2/1rSf0r4lupk



Tapi di Blender kita dapat menggabungkan obyek atau animasi

3d kita dengan fi lem atau video yang kita capture dengan

handycam. Oleh karena itu saya akan membuat sebuah tutoria l

sederhana cara menggabungkan kedua obyek yang berbeda,

disatu sisi kita membuat animasi 3d namun backgroundnya

adalah video yang kita rekam menggunakan handycam.

Tutorial ini menggunakan sebuah bantuan software yang gratis

juga (setidaknya untuk pemakaian yang non comersial ) yaitu

program Voodoo yang kini telah hadir versi yang ke 7.

Voodoo adalah program camera tracker dimana

menconversikan animasi video hasi l capture menjadi titik-titik

semu sebagai titik bantu (yang membantu untuk peletakan

obyek 3d) dan juga cameranya yang bergerak dalam program

blender sesuai dengan gerakan video hasi l rekaman kita. Untuk

program Voodoo disertakan dalam source fi le [dot]BlendMagz04

ini .

Zaki Abdul Wahid
Umur 32th Gresik Jatim
Website:
besuki04.blogspot.com
Email :
zakssiraj77@yahoo.com
Hobby :
kesengsem sama
opensource nyesel ngak
dari dulu

Banyak sekal i kita mel ihat fi lm yang menggabungkan

antara obyek 3d dengan video l ive yang diambi l dan

capture untuk menjadikannya fi lem yang bermutu. Contoh

fi lem seperti Transformers, atau Fantastic 4 dan banyak

lagi membuat fi lem dengan gabungan banyak effek dari

obyek 3d yang berjalan hingga effek ledakan-ledakan

yang fantastis seakan-akan ri i l dan beneran.

Fi lm ruang angkasa seperti Star Trek atau Star Wars juga

memakai berbagai teknik yang menggabungkan animasi

3d dengan video yang shoot. Teknik background layar

hi jau atau biru yang bermaksud mengambi l background

lain dengan obyek yang lain juga didepannya ditempat

yang lain dan menggabungkannya menjadi satu video

yang banyak penontonnya tidak percaya bahawa itu

adalah hasi l pangabungan, teknik tersebut bernama color

matte, banyak teknik yang lain seperti Alpha Channel .

Camera TrackerBlender 2.49 + Voodoo
1 Membuka program blender kita,

saya menggunakan versi 2 .49b.

2 Hit Ctrl+ A dan delete untuk

menghapus seluruh obyek yang ada di

scene blender kita.

3 Posisikan pada top view

4 Tekan space bar (atau shift A kalo di

2 .5) dan pi l ih camera.

5 Kini kita harus mengspl it

windownya menjadi 2 dan memil ih

bagian kanan merubahnya menjadi

window video sequence editor, ini lah

hebatnya blender dimana programnya

lengkap bisa buat video editing, dan

juga membuat games.

FILE SEQUENCE TARGA

Bagian 1

8 Pi l ih Video yang menjadikannya

background. Dalam kasus ini pi l ih koridor.avi

(fi lnya ada pada source fi le majalah ini ) .

9 Setelah keluar movienya langsung kita

bisa grap atau pindahkah movinya ke frame 1

pada track 1.

6 Konsepnya adalah bahwa video kita akan

kita render kembal i ke dalam bentuk TARGA

dimana fi le TARGA adalah fi le yang dapat

dibaca oleh Voodoo. Dan juga menjadikannya

sequnceses atau frame by frame

7 Pada editor video squence tadi kita kl ik

Add – kl ik Video

10 Kita tekan F10 pada keyboard untuk

masuk pada panel render.

11 Hal pertama yang harus kita perhatikan

adalah dimensi dari video kita dalam kasus ini

dimensinya adalah 720 x 576 maka untuk

aspek X menjadi 54 dan Apek Y menjadi 51

yaitu aspek baku dari PAL.

[dot]BlendMagz 04



12 Jangan lupa tombol do Sequnece juga

dinyalakan.

13 Start framenya (dalam kasus ini ) = 1,

finish framnya adalah 250.

14 Simpan hasi l targanya di folder yang

sesuai .

15 Tekan ANIM. (maka render akan

berjalan dan menyimpan hasi l TARGA-nya

difolder yang telah ditentukan).

1 Yakinkan bahwa program Voodoo sudah terinstal l .

2 Ja lankan Voodoo.

3 Kl ik menu fi le – Open – Sequence.

4 Selanjutnya tentukan foldernya dan pi l ih fi le pertama

dari folder TARGA tadi .

Membuat file Python
menggunakan Voodoo

Bagian 2

5 Tentukan startnya dan end atau finishnya

6 Set Move Type : menjadi free move

(karena camera dalam keadaan bergerak)

kalau pi l ihan tripod adalah untuk camera

yang standing tidak bergerak.

7 Set Interlace menjadi not.

8 Kl ik Ok!

9 Setelah di OK akan muncul

panel

seperti berikut:

10 Kita tinggal menekan

track dan wal laaaa ….apa

yang terjadi?

11 Akan muncul sebuah

titik atau plus warna hi jau

sebagai track atau tanda. Juga

panel progress.

12 Tunggu hingga progress menjadi 100% ini penting

walau prosesnya begitu lama namun mohon untuk benar-

benar ditunggu karena sangat penting untuk lanjut ke tahap

selanjutnya.

13 Keterangan yang dalam bentuk DOS ini adalah

notice atau catatan bi la terjadi error. Dia akan berjalan

cepat bi la terjadi proses.

14 Tanda bahwa proses selesai adalah bi la ada catatan dos sebagai berikut:



15 Selanjutnya adalah kita menyimpan proses ini kedalam fi le

phyton sebuah fi le script yang bisa dibaca oleh blender.

16 Pi l ih nama yang dikehendaki .

17 selanjutnya save.

Proses meletakkan dan
menjalankan script python

Bagian 3

1 Buka kembal i blender.

2 Hi langkan semua object yang ada.

3 Spl it windownya menjadi 2 .

4 Window yang kedua di jadikan text

editor.

5 Kl ik Text dan open – arahkan ke fi le

phyton tadi .

6 Exsekusi dengan ALT P atau Run Python

Script.

7Dan apa yang terjadi pada scene kita

akan terl ihat titik-titik hi jau yang dari

voodoo menjadi titik-titik hitam yang

fungsinya adalah sebagai acuan dari

peletakan obyek kita nanti .

8 Tekan 0 pada keypad untuk view camera.

9 Kl ik menu View dan pi l ih background dan set

backgroundnya dengan mengarahkan fi le targa yang

kita buat tadi .

10 Letakkan obyek seperti contoh atas terdiri dari

UV Sphere, plane dan Lamp.

11 Beri material yang cocok sesuai selera khusus

untuk plane pi l ih only shade agar tidak terl ihat ketika

dirender namun effek bayangan tetap ter-render.

1 Setelah bagian 3 selesai

2 Kembal i ke window Video Sequence Editor

3 Add movie avi kita yang pertama

4 Add Scene kita

5 Terakhir (dan ini penting) select Scene kita (terlebih

dahulu) tekan shift dan pi l ih movie kita.

6 Selanjutnya kita kl ik add effect – Alpha Under

7 sehingga urutannya sebagai berikut (gbr.)

8 Perhatikan pada Alpha Under tertul is 1>2 yang artinya bahwa movie kita

berada dibagian bawah dan ditumpuk oleh scene kita yaitu obyek tadi namun

backgroundnya hi lang dan mengikuti background movie kita.

9 Sekarang tahap terakhir adalah Rendering Movienya.

10 Set ke AVI Codec

11 Simpan fi lenya sesuai keinginan

12 Dan ANIM! Lihat hasi lnya ASIK KAN?

Bagian 3

Rendering dg
Alpha Down





.DADAT

BLENDER 2.5 SCULPTING

.DADAT
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BUDIP GALLERY
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.vw [wip] by budip

inblender. blogspot. com



.CALL ME
WISNU SEKTY GALLERY

BOSS
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.

http: //goodboy-deviantart. deviantart. com/



.skyland
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.ant_v [wip]
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.skateboard
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WIP: Game Character Modeling
.frawn





MIKU
FEAT
AFU
by sepeda saurus
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Pada tutoria l disini sengaja difokuskan ke teknik

animasi menggunakan Physics. Tidak di jelaskan

secara detal proses pemberian maps dan sebagainya

karena pada tutoria l di edisi sebelumnya sudah

tercantum.

Kamu dapat mengoprek isi dari fi le sumber yang

disertakan pada source download bebarengan

dengan edisi ini . Diharapkan army bisa berpikir

secara terpola dan paham dengan mempelajari

fi lenya. Kamu juga bisa mel ihat versi timelaps video

di youtube yang l inksnya disertakan di bawah ini .

Selamat berproses. J ika ada pertanyaan si lakan

masuk ke forum Blender Indonesia dan berinteraksi

dengan Blender Army lainnya.

http: //www.youtube.com/user/kaptenblenderyoutube!

.timelaps



.vw [wip]

* Buat model dasar bendera dari Mesh>Plane dan tiang bendera dari

Mesh>Si l inder

* Untuk Plane: Edit mode>Subdive (secukupnya)

Shortcut Subdive: W (specials>subdive)

.modeling dasar Tekan T pada

keyboardmu untuk

memunculkan fasi l i tas

Tool Shelft

* Blender mempunyai

fasi l i tas untuk

memudahkan seleksi .

Seleksi group sangat

berguna untuk menyeleksi

berdasarkan group.

* Lakukan seleksi (B) di

area bendera yang

nantinya tidak ikut

berkibar. Beri nama

seleksi_1 dan kl ik Assign

.seleksi
group

* Masuk ke Wight Mode

* Lakukan weight paint di

area seleksi_1 (warna

merah)

* Area biru tanpa weight

paint karena kita akan

buat menjadi berkibar

* Masuk ke Properties di

sebelah kanan ujung dan

Add Cloth. Lakukan sesuai

gambar disamping.

.weight
paint

* Sebelum play tambahkan

terlebih dahulu Force Field

(shift+A)>Wind (angin).

Setting sesuai gambar

disamping.

* J ika di l lakukan dengan

benar, maka setelah di

Play bendera akan

merespon angin dan

berkibar dengan kekuatan

terntentu.

NOTE: jangan lakukan play

dengan ATL+A.

.ready to
play?



* Masuk ke panel

Properties>Render.

* Setting dengan format PAL

video (preset) ; Start dari

frame 100 -250, dengan frame

rate 25 fps (frame/second)

* Jangan lupa untuk

mensetting output folder.

* Ektension fi le adalah AVI

JPEG (kompresi jpeg).

* Setelah OK maka Kl ik

Render>Animation dan tunggu

hasi lnya.

* PLAY

*

NOTE:

Setting ini tidak dianjurkan

untuk animasi komplek. Pada

animasi yang komplek dan

berat disarankan untuk

emrender dengan PNG

sequence untuk menghindari

hang/eror pada saat proses

render berjalan. Sehingga

sisanya bisa di render dari

frame terakhir.

.render
animasi








